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1 Introduction 
This user’s guide is designed as a learning tool and technical reference 
for use with the Proxis Stock Manager software.  If at any time you 
require technical support or custom programming please contact our 
help desk at 1-877-477-6947. 

1.1 What is Stock Manager? 
Stock Manager is a standard Windows desktop application for tracking 
inventory items using barcode labels and a barcode scanner. 
 

 
 

Figure 1. Stock Manager Main Screen 
 
Stock Manager is a simple but powerful inventory management tool 
designed for use with both keyboard wedge barcode scanners as well as 
mobile devices like the CIPHERLAB 8000 Series, Janam XP Series, 
Aceeca Mezura, the Symbol SPT Series.  Stock Manager will also work 
on most Window CE and Windows Mobile barcode scanners.  
 
Stock Manager is very effective for simple inventory tracking like a 
supply closet or CD collection, but is also designed for more complex 
inventory functions such as doing physical inventories with a mobile 
barcode scanner, printing barcode labels with a mobile barcode printer, 
keeping track of serialized items, creating invoices, creating purchase 
orders, and keeping track of inventory stored in separate locations. 
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1.2 Stock Manager Features and Benefits 
Stock Manager’s features provide the following benefits: 

• Improved Inventory Turns 
• Improved Cash Flow 
• Increased Security 
• Reduced Cost of Physical Inventory Process 
• Improves Inventory Retrieval Times 

 
Features include: 

• Barcode Printing with Mobile Printer Support 
• Barcode Scanning 
• Physical Inventory Comparison Reporting 
• Basic Invoicing 
• Automatic Purchase Orders 
• Low Inventory Reporting 
• Inventory Valuation 
• Data Export (CSV – comma separated value) File 
• Data Backup 
• Mobile Barcode Scanner Integration for remote management 
• Keychain Scanner Support 

 
The mobile barcode scanner programs offer the same functionality 
on a small and portable platform: 

• Price Lookup 
• Location Lookup 
• Receive Items 
• Enter New Items 
• Edit Item Information 
• Physical Inventory Scanning (support for a full range of barcode 

scanning devices) 
• Item Calculator (Cost and Price Palm and Windows CE Only) 
• Barcode label printing (Palm and Windows CE only) 

 
Stock Manager Mobile options: 

• Integrates with choice of Palm, Windows CE, OPN2001 
Keychain Scanner or the Cipher Lab 8001. 

• Provides mobile label printing on Epson, Zebra and Datamax-
Oneil mobile barcode printers. 
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1.3 Installation 
To install Stock Manager, double click the SetupStockManager.exe icon 
and follow the installation steps.  The application is installed to the 
c:\Proxis Software\Stock Manager folder by default. 
 
After installation, the Stock Manager application can be purchased and 
registered to unlock the demo mode.  Demo mode is limited to 10 
inventory items.  Please call us to locate an authorized reseller. 
 
The Stock Manager installer will automatically create a shortcut to the 
program on the desktop and in the Windows Start Menu. 
 

 
 

Figure 2. Stock Manager Welcome Screen 
 

1.3.1 Operating System Compatibility  
Stock Manager is compatible with the following operating systems: 

• Windows 2000 
• Windows XP 
• Windows Vista 32 
• Windows 7 
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1.3.2 Registration and Activation 
 
To register and activate the full version of Stock Manager: 

1. Copy down the Registration Number found in the Product 
Registration screen. 

2. Purchase a software license from a Proxis reseller.  Please 
contact us for a list of authorized resellers. 

3. The Proxis reseller will issue an activation code based on the 
registration number. 

4. Mobile device licenses must also be purchased for using Stock 
Manager Mobile barcode scanning software. 

 

 
 

Figure 3. Product Registration Screen 
 
Stock Manager is registered per machine and can be used in a 
networked, multiuser environment.  It is recommended that the 
number of networked users is limited to 5-10.  For more users please 
contact us. 
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1.4 Hardware Setup 
Stock Manager works with a variety of different hardware combinations.  
Most commonly, Stock Manager is loaded on a computer with a tethered 
keyboard wedge scanner and barcode printer attached.   
 
A mobile barcode scanner can also be used to perform physical 
inventory and to lookup pricing when the user is away from the main 
computer. 
 
1.4.1 Keyboard Wedge Barcode Scanner Setup 

1. Plug the scanner into the computer per the connection type.  
 
1.4.2 Cipher Lab 8000 Series Mobile Barcode Scanner Setup 

1. Plug the Power Supply into a wall outlet. 
2. Plug the USB Cable into an available USB port. 
3. Plug both Power Supply and USB cable into the Cradle. 
4. Windows will prompt for a driver location. 
5. Insert the supplied driver disc. 
6. Select the drive letter associated with the driver disc. 
7. The system will automatically assign a COM port for the device. 

 

 
Figure 4.  USB Cradle Driver Location with associated COM port 

(COM3) 
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Figure 5.  Device Settings 
 

1.4.3 Palm Barcode Scanner Setup  
1. Plug the Power Supply into a wall outlet. 
2. Plug the USB cable into an available USB port. 
3. Plug both Power Supply and USB cable into the Cradle. 
4. Install the Palm Desktop Software from one of the following 

locations: the Stock Manager CD, Palm Website, Proxis Website 
or Proxis Reseller Website. 

5. Setup Palm Hot Sync to sync with a scanner device. 
6. Synchronize the Palm device to create a User ID. 
7. Purchase and Register the Stock Manager application in Mobile 

mode.  
8. Install Stock Manager Palm software by clicking Synchronize 

then Install Device Software.  Refer to Figure 6. 
9. Follow the installation prompts.  Hot Sync will be shut down and 

restarted.  If a message appears asking to allow this, click Yes. 
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Figure 6. Install Mobile Software from Stock Manager 
 

1.4.4 Windows CE Barcode Scanner Setup 
1. Plug the Power Supply into a wall outlet. 
2. Plug the USB cable into an available USB port. 
3. Plug both Power Supply and USB cable into the Cradle. 
4. Install the Microsoft Active Synch software from one of the 

following locations: the Stock Manager CD, Microsoft Website, 
Proxis Website or Proxis Reseller Website. 

5. Setup Active Sync to sync with the scanner device. 
6. The Windows CE device will synchronize with the computer. 
7. Purchase and Register the Stock Manager application in Mobile 

mode.  
8. Install Stock Manager Windows CE software by clicking 

Synchronize > Install Mobile Software.  Refer to figure 6. 
9. Ensure that Windows CE is select then click OK. 
10. Follow the installation prompts.  

 
 



ProxisSoftware.com Customer Service: 1-877-477-6947 13

 
 

Figure 7. Microsoft ActiveSync 
 

To activate the Stock Manager Mobile software: 
1. Scan the barcode on the plastic card received with the purchase 

of the mobile scanner and mobile software license. 
 

 
 

Figure 124a.  Splash Screen 
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Figure 124b. Scan or Enter the Activation Code  
 

The Stock Manager Mobile Device License is a plastic card with a 
barcoded activation code.  The code is scanned to activate the mobile 
device software. 

 

 
 

Figure 124a. Stock Manager Mobile Device License 
 
1.4.5 Barcode Printer Setup 
Please refer to the barcode printer’s setup instructions.  The barcode 
printer must be plugged in with its drivers loaded before Stock Manager 
will work with it. 
 
Compatible Desktop Barcode Label Printers: 

• Zebra - all models  
• Cognitive – all models 
• Epson – TM L90 



ProxisSoftware.com Customer Service: 1-877-477-6947 15

• Brother – barcode printer models 
• Standard Laser Printers – with Avery labels 

 
Most barcode label printers will work with Stock Manager.  Please 
contact us for specific label design. 
 
For assistance, contact the Proxis Help Desk at 1-877-477-6947. 
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1.4.6 Keychain Scanner Setup 
A keychain scanner is an inexpensive barcode scanner similar in size to 
a key fob.  The scanner has no user interface but will store thousands of 
scans.  The scanner can be used with Stock Manager to add inventory, 
subtract inventory, create invoices, perform physical inventory 
comparisons, and create purchase orders. 
 

 
 

Figure 8. Installing the Keychain Scanner 
 
To install the keychain scanner: 

1. Plug the USB Cable into an available USB port. 
2. Windows will install a driver automatically (OPN2001 only). 
3. The system will automatically assign a COM port for the device. 
4. Browse to the Device Manager from the Windows Control Panel. 
5. Make note in the Device Manager of the COM port assigned to 

the device.  This will be needed later when syncing the device. 
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2 Getting Started 
Getting started is easy: Double click the desktop icon and start scanning. 
 

 
 

Figure 9. Stock Manager Desktop Icon 
 
If the inventory items do not have barcodes enter them in by hand.  Later 
in this manual we’ll explain how to print barcode labels for these items. 

2.1 Preferences and Settings 
The Settings and Preferences screen provides the ability to modify 
application settings including: 

• What barcode printer will be used. 
• The barcode label format. 
• What reports printer to use. 
• Choosing a Mobile Barcode Scanner. 
• Selecting a Database Location (for networked multi-user 

applications). 
 

 
 

Figure 10. General Options Tab 
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2.1.1 General Options Tab 
 
Max History Record Size:  
This setting specifies the number of history records shown on the History 
tab.   
 
Show Product Editor on Item Found: 
Open the product editor screen when scanning items from the Inventory 
tab. 
 
Enable Partial Search: 
Look up items by search terms that might not be an exact match. 
 
Save User on Exit: 
Maintains the same user when exiting the application. 
 
Re-Enter User for Each transaction: 
Forces the user to enter their user name after every scan. 
 
Enable Store Manager Integration: 
Use Stock manager as a conduit between Proxis Store Manager POS 
software and a mobile barcode scanner.  This feature is useful for 
uploading product information from the Store Manager database to a 
mobile barcode scanner to add, subtract or update item information. 
 
Inventory Database Location: 
This function allows a large number of users to simultaneously access 
the same database for inventory control.  It is advised that the shared 
database is placed in a network shared directory for multi-user 
applications. Please consult our help desk for more information on 
setting up Stock Manager in a multi-user environment.  Stock Manager 
will use the default inventory database in the installation folder if this field 
is left blank. 
 
Default Report Printer: 
From the list of available printers, select the printer that will be used for 
printing reports.   
 
A default report printer must be selected to preview reports.  If no printer 
is installed please contact tech support for assistance installing a stand-
alone pdf printer driver. 
 
Change Password: 
Click this button to modify the administrator password.  The original 
admin password set during the setup wizard must be entered first.  
Please contact us if you have lost this password. 
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Figure 11. Scanner Settings 
 

2.1.2 Scanner Settings Tab 
Use the Scanner Settings tab in Figure 11. to integrate the mobile 
barcode scanner.  Some scanners will display extended communications 
properties when selected. 
 
Mobile Scanner: 
From the Mobile Scanner list, select the barcode scanner to be used.   
 

• Cipher Lab 8000 - All Cipher Lab 8000 series and compatible 
scanners. 

• Palm Scanner – The Janam XP20 and XP30 series and the 
Aceeca IDVERIFI. 

• Windows CE Scanner – Motorolla, Honeywell, Datalogic, and 
Unitech mobile Windows based barcode scanners.  Stock 
Manager will also work with most Windows CE or Windows 
Mobile PDA without barcode scanner support. 

 
Comm Port Settings: 
For use with the 8000 Series barcode scanner only.  Select the correct 
communications port that the scanner’s cradle is connected to.  Refer to 
the hardware installation instructions (section 1.4) for further information. 
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Figure 12. Barcode Settings 
 
2.1.3 Barcode Settings Tab 
Barcode Settings sets the barcode printing options for Stock Manager. 
 
Default Barcode Label: 
Select from the list of label templates available.  If the desired label 
format isn’t found in this list, the Proxis help desk can design a custom 
label format.  Barcode label templates are created with Crystal Reports 
8.5. 
 
Default Barcode Printer: 
From the list of available printers, select the printer to be used for 
barcode printing.  The selected printer should correspond to the selected 
barcode label format.  Label formats have been developed for the 
following printers: 

1. Avery labels can be used with most laser and inkjet printers. 
2. All Zebra printers. 
3. Epson TM L90. 
4. All Cognitive Printers. 

 
Print Barcodes When Adding/Receiving Items 
Enabling this option will automatically print a barcode to the default 
printer when an item’s quantity is increased (using the Add tab and 
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during Mobile Scanner synchronization).  Any new items received on a 
mobile scanner will automatically have a barcode printed to the default 
barcode printer. 
 
Queue Barcodes: 
The Queue Barcodes feature will create a print job of barcodes to be 
printed.  This feature is useful for printing barcodes on Avery labels 
sheets.  Please refer to section 3.1 for label printing instructions. 
 

 
 

Figure 13.  Adding barcodes to the print queue 
 

 
 

Figure 14. Managing the Barcode Printing Queue 
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Figure 15. Tax Rates 
 
2.1.4 Tax Rates Tab 
Two tax rates can be used when creating Invoices in Stock Manager.  
Tax 2 can also be a Flat Rate tax. 
 
To enable Tax 1 Rates for Invoicing: 

1. Enter the tax rate the Tax Rate field. 
2. Modify the Display Text if needed. 
3. Check the Enable Tax 1 checkbox. 
4. Repeat for Tax 2 if needed. 

 
2.1.5 Company Info Tab 
The Company Information setting are used to display company name, 
street address and contact information on Invoices and Purchase 
Orders. 
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Figure 16. Company Information Tab 
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2.2 Customizing Column Labels and Tabs 
Stock Manager can be customized to fit individual and unique business 
situations by changing the names of tabs and data columns. 
 

 
 

Figure 17. Customize Text Tab 
 
The Customize Text screen is found under the File menu (File > 
Customize Text) and is used to modify the text shown on both the main 
screen’s tabs as well as the columns in the data field.  For example the 
Add tab could be renamed Receiving and the Subtract tab might be 
labeled Shipping.  A data column could be renamed from Vendor to 
Building.   
 
Customizations will also appear on Stock Manager reports, however they 
will only appear on the mobile barcode scanner application when using a 
Windows CE type scanner. 
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2.3 Managing Users 
The Users setting assigns a user to each scan.  This is used to 
determine who scanned each item over a particular time frame.   
 

 
 

Figure 18. Customize Text Tab 
 

To add a new user: 
1. Click on New. 
2. Enter the user’s name in the Username field. 
3. Click on Save. 

 
Users are selected from each scanning tab.  The Preferences and 
Settings can be changed to prompt for a user after every scan.  Users 
can be deleted from the list of available users; however their history 
information will remain in the database. 
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2.4 Managing Customers 
This form manages customer information for use by the Invoice function 
to print invoices and adjust inventory quantities. 

 

 
 

Figure 19. Customer Information Management 
 

To enter a new customer: 
1. Click on the New button. 
2. Enter the customer’s information. 
3. Click on the Save button. 

 
To edit a customer’s information: 

1. Select a customer or enter their name in the Search Text field. 
2. The Search Field will limit the number of customers in the Select 

Customer list to help find the right customer quickly. 
3. Modify the customer’s information. 
4. Click on Save. 
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2.5 Managing Vendors 
Vendor information is used by the Purchase Order function to add the 
vendor’s name and address to the Purchase Order automatically.  The 
Vendor Management form can be used to add new vendors, edit existing 
vendors and delete unused vendors for use with the purchase order tab. 
 

 
 

Figure 20. Vendor Information Management 
 
To enter a new customer: 

1. Click on the New button. 
2. Enter the customer’s information. 
3. Click on the Save button. 

 
To edit a customer’s information: 

1. Select a customer or enter their name in the Search Text field. 
2. The Search Field will limit the number of customers in the Select 

Customer list to help find the right customer quickly. 
3. Modify the customer’s information by typing over their existing 

information. 
4. Click on Save. 
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3 Working with Inventory 
Stock Manager manages inventory items from a main inventory screen.  
Use the tabs on this screen to access commonly performed inventory 
functions. 
 
The main inventory screen is comprised of 7 tabbed function screens: 

• Inventory 
• Add  
• Subtract 
• Invoice 
• Compare 
• Purchase Order 
• History 
 

Click on the tab to perform the function it describes.  The Add tab will 
add inventory item quantities; the Subtract tab reduces inventory 
quantities; the Invoice tab generates invoices for customers; the 
Compare tab will compare inventory item quantities with the values 
scanned during a physical inventory; the PO’s tab generates purchase 
orders; the History tab shows a chronological history of operations 
performed on the inventory. 
 
Each function that modifies inventory levels (Add and Subtract) includes 
a history grid to display recent scans and undo those scans if necessary. 
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3.1 Main Inventory Screen 
The Inventory tab displays the entire list of inventory items in its grid.  
This screen provides a search function for finding items in the main 
inventory grid. 
 
There are also 7 functional tabs: 

• Inventory – lists all items in the inventory 
• Add – increase an item’s quantity 
• Subtract  - decrease an item’s quantity 
• Invoice – sell items to customers 
• Compare – perform physical inventories 
• PO’s – create purchase order automatically 
• History – view a history of recent inventory transactions 

 
The labels of these tabs can be customized from the File > Customize 
Text menu. 
 

 
 

Figure 21. Main Inventory Screen 
 

On most tabs, scanning an item not found in inventory will result in a 
prompt to add it.   
 
The inventory grid has buttons for editing items and printing barcodes for 
specific items.  Double clicking an item or clicking the item’s Edit button 
will open the editor screen. 
 

Function 
Tab 

Scanning 
Box 

Inventory 
Grid Barcode 

Printing 

Edit Item 
Information 
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Right clicking on an item will open a menu of typical actions that can be 
taken on an item such as:  Edit, add quantity, subtract quantity and print 
barcodes.  Refer to Figure 22. 
 

  
 

Figure 22.  Right clicking on an item
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3.1.1 Adding and Editing Items - General Tab 
After scanning or clicking an item, the Add Inventory Item or Edit 
Inventory Item screen will appear.  This screen provides access to add 
inventory, modify item information and print barcode labels. 

 

 
 

Figure 23. Add Item Screen General Tab 
 

The General Tab contains standard item information such as: 
• Item Number 
• Description 
• Default Location 
• Qty (quantity in stock) 
• Vendor 
• Notes 
• Track serial number for the item 
• Show that the item is a kit with sub-items. 

 
Item Number: 
This is the item’s barcode or stock keeping unit.  This field is required. 
 
Description: 
The name of the item or product the barcode is assigned to.   
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Default Location: 
The default location is set during the initial start up wizard and is 
automatically entered in this field.  This value can be changed.  While 
other locations can be added for an item, the new value becomes the 
item’s default location.  Refer to section 3.1.3 for more information on 
working with multiple locations. 
 
Qty: 
Enter the starting quantity, if known, for an item.  Set this value to 0 
(zero) if using serial numbers.   
 
Serial Numbers:   
When this feature is used the Add, Subtract, Invoice and PO tabs will 
prompt for a serial number when the item is scanned.  
 
When turning on the serial number feature make sure to enter 0 (zero) 
for item quantity and use the Add tab to increase starting quantities.   
 
Kits: 
Check this box to indicate that the item is a kit.  A kit item will have sub-
items that accompany it.  Please refer to section 3.1.5 for more 
information on working with items in a kit. 
 
The OK button at the bottom of the screen saves all entries and exits to 
the main screen. 
 
The editor screen has a Delete button that removes the item and all 
associated item reporting from the inventory grid. 
  
To un-delete an item, simply scan or enter its item number from any tab.  
This will prompt the user to re-enable the item with its item information 
intact.  
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3.1.2 Adding and Editing Items - Prices Tab 
 

 
 

Figure 24. Prices Tab 
 

Item Pricing: 
The Prices tab shows the three pricing levels that can be set for items: 

• Cost – the amount that was paid for an item. 
• Price – what the item will sell for.  Also called retail price. 
• MSRP – the manufacturers suggested retail price. 

 
Tax Rate: 
Two tax rates can be applied to every item.  Tax rates are typically only 
used with the Invoicing function.  These tax rates are defined in the 
Preferences and Settings.   Tax 1 is a percentage tax. Tax 2 can be a 
percentage rate or a flat (or fixed) amount. 
 
A typical use of Tax 2 is for taxes like GST, VAT, or adding a specific 
shipping charge for an item. 
 



ProxisSoftware.com Customer Service: 1-877-477-6947 34

3.1.3 Adding and Editing Items – Location Tab 
The Location feature tracks an item’s quantity at separate locations.  
When adding and subtracting inventory or generating invoices and 
purchase orders, Stock Manager will check to see if there are multiple 
locations to pull from.  If there are and the “Prompt for Location” setting is 
selected, then, Stock Manager will prompt the user to choose the 
location from which inventory is coming from or going to. 
 
The location tab is used to show how many items are at each location, 
set the preference for prompting location, add a new location, set a 
location as a default, transfer inventory from one location to another, and 
remove locations. 
 

 
 

Figure 25. Location Tab 
 
To add a new location for an item: 

1. Click the Add Location button. 
2. Enter the new location name. 
3. Transfer inventory into the new location if needed. 

 
Setting a default location: 

1. Click on the location to be the default. 
2. Click on the Set as Default button. 



ProxisSoftware.com Customer Service: 1-877-477-6947 35

To transfer Inventory from one location to another: 
1. Select the location to transfer from. 
2. Click on the Transfer button. 
3. On the Transfer Inventory form, enter the quantity to transfer. 
4. On the Transfer Inventory form, select the location to transfer to. 
5. Click Transfer. 

 
To remove a location: 

1. Select the location to delete. 
2. Click on Remove. 
3. Click OK to permanently delete a location. 
4. A prompt to transfer inventory will appear if there is inventory 

showing at that location. 
 

 
 

Figure 26.  Transferring Inventory 
 

 
When scanning items in and out a prompt will appear if the “Prompt for 
Location” setting is enabled.  This prompt allows the user to either scan a 
location or select the location from a list.   
 
The default location will be used if the location isn’t changed. 
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The items location will be chosen when the user scans an item in or out 
of inventory using the Add, Subtract, Inventory, or PO functions. 

 

 
 

Figure 27. Entering the Location when scanning items out 
 
 

 
 

Figure 28. Entering the location while receiving 
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3.1.4 Adding and Editing Items – Limits Tab 
 

 
 

Figure 29. Reorder Tab 
 

The Reorder point field sets the re-order point for an item.  The Low 
Inventory report will show all items that have reached their Reorder Point 
thresholds and need reordering. 
 
These values are also important for the Purchase Order feature in Stock 
Manager.  On the PO tab there is a button that’s labeled Reorder.  When 
this button is clicked for a particular vendor or for All Vendors, Stock 
Manager adds items that have gone below their reorder point and adds 
enough quantity to the purchase order to bring the item’s stock level to 
the “Reorder up to” amount. 
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3.1.5 Adding and Editing Items – Kits Tab  
Enabling an item to be a kit allows other inventory items to be associated 
with it as sub-items.  The Subtract preferences on the bottom of the form 
will determine whether a component of the kit will have its inventory 
quantity reduced when the kit is built or when it is shipped. 
 
The Kit checkbox must be selected on the General tab to enable the kit 
features for a particular item. 
 

 
 

Figure 30. Managing a Kit 
 
To add a component to a kit: 

1. Scan or enter the barcode in the Item Number field. 
2. Enter the quantity of components for the kit. 
3. Check the “Add this item to PO” when reordering checkbox if 

desired.   
4. Click Save. 

 
To edit a component in a kit: 

1. Select the component from the list. 
2. Click on Edit. 
3. Modify the barcode or quantity. 
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To remove a component in a kit: 
1. Select the component. 
2. Click Remove. 
 

To select the subtraction method for the components when the kit 
is removed from inventory: 

1. Click on “Building the kit” to subtract component parts when 
adding a kit inventory quantity to inventory. 

2. Click on “Selling/Shipping the kit” to subtract component parts 
from inventory when selling or shipping the parent kit. 

 
Note:  Kits can be subcomponents of larger kits. 
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3.1.6 Adding and Editing Items – Serial Number Tab 
To track serial numbers for a particular item first select “Track Serial 
Numbers for this item” on the General Tab. 
 
The “Enter serial number” prompt will pop up when adding or removing 
items that have serial number tracking enabled. 

 

 
 

Figure 31. Enter serial number 
 
 

 
 

Figure 32. Serial Number Tab 
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Serial numbers are tracked when scanning items in and out of inventory.  
The Date Added shows the date and time a serialized item was added.  
The Date Removed fields show when it was scanned out of the system. 
 
To view the item’s serial number history: 

1. Double click on the Serial Number row on the grid on the Serial 
Numbers tab. 

2. The View History button will also open the Serial Number History 
form for a highlighted serial number. 

 

 
 

Figure 33. Serial Number History 
 
Figure 33. shows the Serial Number History form.  The form lists the 
item’s description, serial number, last added date, last removed date, the 
last user to scan the serial number and the item’s notes.  The Serial 
Number History form shows a list of transactions, both in and out, for that 
particular serial number. 
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3.2 Add Screen 
The Add tab adds/receives the quantity specified (in the Quantity field) 
for the scanned item, increasing the stock quantity.  The History of 
Additions grid shows a historical list of scans. 
 

 
 

Figure 34. Add Screen 
 
The Clear button will reset the Enter Item Number field and set the 
Quantity field to 1 (one).  The Quantity field must be changed before an 
item is scanned. 
 
To Receive a Large Number of a Certain Item: 

1. In the Quantity field, enter the number of items to add. 
2. Scan one of the items in the lot. 
3. The scan will appear in the History of Additions grid. 

 
To Undo a Scan (Caution clicking the undo button is not reversible): 

1. Locate the scan to be deleted in the History of Additions grid. 
2. Click the Undo button for that scan. 
3. The quantity addition will be undone and the quantity increase 

reversed. 
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3.2.1 Importing from a Keychain Scanner 
A Keychain Scanner is a small barcode scanner called the Opticon OPN-
2001.  This scanner has two buttons one for scanning barcodes and the 
other for deleting the last scanned barcode.   
 
Keychain scanner data can be imported to the Add, the Subtract, 
Invoice, Compare and PO’s tabs.  All of the data on the scanner will 
import into a single tab function.  Stock Manager then clears all data from 
the scanner if the Clear Data After Import option is checked. 
 
If an item on the scanner is not found in the inventory database, a 
prompt will appear asking the user to add the item. 
 

 
 

Figure 35. Keychain Scanner Import 
 

To add inventory quantities using a keychain scanner: 
1. Scan each item you wish to add.  All items must be scanned.  

There is no function for entering a quantity number. 
2. Connect the scanner to the USB port.  Note what Com port has 

been assigned to the scanner.  This setting will be saved. 
3. Click on the Import from Keychain Scanner button. 
4. Select the Scanner Port from the drop down box. 
5. Click the Add button to import data.   
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3.2.2 Setting the Current User 
The Current User field is used to track who is working with Stock 
Manager at a given time.  The Current user is typically set and changed 
after a shift.  A setting is available to prompt for a user after every scan. 

 

 
 

Figure 36. User Management 
 

To Add and Select and new user: 
1. Click the New button. 
2. Enter their name in the Username field. 
3. Click on Select. 

 
To select a previously added user: 

1. Select the user from the Select User drop down box. 
2. Click on the Select button. 
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3.2.3 Setting a Location When Adding Items 
To set a location for an item when adding it the Prompt for Location 
setting must be selected on the Location tab in the Edit Item screen.  
When using multiple locations for an item a prompt will appear that lists 
each location and how many items should be at that location. 
 
Locations can either be scanned into the location field or selected from 
the list.   
 

 
 

Figure 37. Entering the location while receiving 
 

To set a new location to add to: 
1. Scan the item to add.   
2. Scan the item’s location or enter it with the keyboard.  The 

Choose Location form opens with the default location 
highlighted.
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3.3 Subtract Screen 
The Subtract tab subtracts/ships the quantity specified (in the Quantity 
field) for the scanned item, decreasing the stock quantity.  The History of 
Subtractions grid shows a historical list of previous scans. 
 

 
 

Figure 38. Subtract Screen 
 
The Clear button will reset the Enter Item Number field and set the 
Quantity field to 1 (one).  The Quantity field must be changed before an 
item is scanned. 
 
To Ship/Subtract a Large Number of a Certain Item: 

1. In the Quantity field, enter the number of items to subtract. 
2. Scan the item. 
3. The scan will appear in the History of Subtractions grid. 

 
To Undo a Scan (Caution clicking the undo button is not reversible): 

1. Locate the scan to be deleted in the History of Subtractions grid. 
2. Click the Undo button for that scan. 
3. The quantity subtraction will be undone and the quantity 

decrease reversed. 
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3.3.1 Setting a Location When Subtracting Items 
If the Prompt for Location setting has been selected for the item being 
subtracted, a Choose Location form will open prompting for a location to 
subtract from.  The Location can be left to the default location, scanned 
into the location field or selected from the list.   
 

 
 

Figure 39. Entering the Location when scanning items out.  
 
To select the item’s default location to remove from: 

1. Click the Select button.  The form opens with the default location 
selected. 

 
To set a new location to subtract from: 

1. Scan the item to subtract.   
2. Scan the item’s location or enter it with the keyboard.  The 

Choose Location form opens with the default location 
highlighted. 
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3.3.2 Subtracting Items in a Kit 
When scanning kits out of inventory there is an option to reduce 
component quantities when the kit is removed from inventory through the 
Subtract tab or the Invoice tab. 
 
To subtract component quantities when selling or shipping a kit: 

1. Open the item editor by double clicking an item 
2.  Ensure the item is enabled as a kit. 
3. Click on the Kits tab. 
4. Select Selling/shipping the kit as the preferred time to reduce the 

component items’ inventory quantities. 
 

 
 

Figure 40.  Subtracting Kits 
 

To subtract component quantities when building a kit: 
1. Open the item editor, ensuring the item is enabled as a kit. 
2. Click on the Kits tab. 
3. Select Building the kit as the preferred time to reduce the 

component items’ inventory quantities. 
 
If “Building the kit” is selected, Stock Manager will subtract a kit’s 
components out of inventory when the kit is added to inventory.
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3.4 Invoice Screen 
The Invoice function is a simple way to scan items out of inventory and 
print a simple receipt/invoice to give to customers for payment.  Taxes 
are applied according to the default rates, but can be excluded for a 
particular invoice. 
 
Invoices can be created and saved for later.  Selecting an invoice from 
the Select Invoice drop down opens pending invoices. 
 
The invoicing function is customizable by Proxis programmers.  Please 
call us for customization requests 1-877-477-6947. 
 

 
 

Figure 41. Invoice Screen 
 
The Invoice tab in Stock Manager provides an Add to Invoice field where 
an item number barcode can be scanned or typed to add items to an 
invoice.  Use the Select Customer area for creating a new invoice and 
assigning a customer to it.  Use the User area for setting the current 
user. 
 
Using the buttons on the invoice form invoices can be deleted, have 
taxes applied to them and can also be generated by importing barcode 
scans from a keychain scanner. 
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The Submit button will show the invoice to be printed and subsequently 
reduces inventory by the quantities of items on the invoice. 
 
To create a new invoice: 

1. Click on the New button. 
2. Either select a customer from the drop down box, search for an 

existing customer or click on the New button to create a new 
customer.  

3. Click Select to select the current customer for the new invoice. 
 

 
 

Figure 42. Customer Management 
 

 
 

Figure 43.  Entering Customer Information 
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To print an invoice: 

1. Click on the Submit button. 
2. The invoice will open in print preview mode. 
3. Click the Printer icon at the top of the screen (see Figure 45) to 

print to the report printer designated in preferences and settings. 
4. After closing the Invoice a prompt will as whether to adjust 

inventory quantities for the items on the invoice. 
 

 
 

Figure 44. Pre-viewing an Invoice 
 
Invoices can also be exported to pdf or a number of other popular 
formats. 
 
To Export to PDF: 

1. Click Submit to view the invoice in print preview mode. 
2. Click on the envelope icon shown in Figure 45. 
3. Click OK. 
4. Select a location and filename to save the invoice pdf. 
5. Click Save. 

 
 

Figure 45.  Exporting an Invoice 
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3.5 Compare Screen – Physical Inventory Count 
The Compare tab is used to conduct a physical inventory comparison.  
This function provides reporting to compare the actual stock scanned 
during a physical inventory count against item quantities listed in the 
Stock Manager database. Comparison scanning from mobile barcode 
scanners may also be “staged” in this area from multiple devices before 
the comparison reports are run.   
 

 
 

Figure 46. Compare Screen 
 

The Comparison Session must have scanned items listed in the 
Comparison Session grid to enable the comparison reports.  These 
scans can come from a wireless barcode scanner or imported from a 
mobile Palm, Windows CE or Cipher Lab barcode scanner.  
 
After running comparison reports for physical inventory counts, click the 
Update Stock Values to update the Stock Manager to the current 
physical count.   
 
To start a new physical count, click the Start a New Session button.  Be 
aware that starting a new session will delete all comparison scans. 
 
The Remove button will remove a scan from the Comparison Session 
grid.  
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3.6 PO Screen 
The Purchase Order function in stock manager allows for easy re-
ordering of items and streamlines inventory management by using an 
item’s Reorder Point and Order Up To quantity. 
 
Stock manager can also re-order components to kits when a kit is added 
to a purchase order. 
 

 
 

Figure 47. PO Screen 
 
To create purchase orders for all items that have fallen below their 
inventory Reorder Points: 

1. Select All Vendors from the Select Vendor drop down. 
2. Click on the Reorder button. 
3. All items that have fallen below their reorder point are added to 

the PO. 
 
To print a purchase order: 

1. Add items to a purchase order. 
2. Click the Print button. 
3. A printable purchase order will be created for each vendor. 
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To save a purchase order for receiving later: 
1. Click the Submit button. 
2. The PO may be recalled at a later date. 

 
To Recall a previous PO: 

1. Click the Recall button. 
2. Select a Purchase order from the list. 

 

 
 

Figure 48.  Select Purchase Orders  
 
To receive all items on a recalled purchase order: 

1. Click the Receive button on the bottom right hand corner of the 
PO form. 

2. Click Yes on the prompt. 
3. Stock Manager will automatically adjust inventory quantities for 

the items received. 
 

 
 

Figure 49.  Receiving a Purchase Order 
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To receive only certain items on a recalled purchase order: 

1. Click the Receive button to the left of the Item. 
2. Enter the amount to be received  
3. Click OK. 
4. Click Save to keep the PO available for receiving the rest of the 

items. 
 

 
 

Figure 50. A sample purchase order 
 

Please contact Proxis Software for custom barcode programming, 
modifications and report design – 1-877-477-6947. 
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3.7 History Screen 
The History tab will show a list of previous quantity changes, product 
additions and product deletions.  This list is ordered by a Time Stamp 
showing when the action occurred.  This list is limited to the Max History 
Record Size setting found in the Preferences and Setting screen. 
 

 
 

Figure 51. History Screen 
 
The History Screen is searchable by Item Number, Vendor, or 
Description.  The History Grid can be ordered by any field by clicking on 
the column header for that field. 
 
The Undo button on the left side of each row will reverse the action 
shown in the Method column. 
 
Be careful! Clicking the Undo button is not reversible. 
 
A detailed History Report is available from the Reports menu.  The 
History report displays a list of transactions for a specific date range. 
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4 Barcode Label Printing 

 
Figure 52. Common Barcode Printers  

 
Stock Manager prints barcode labels using common barcode and laser 
printers.  There are a number of predefined label formats to choose from 
including sheets of Avery-style mailing labels.  Label templates are 
created in Crystal Reports 8.5 and can be modified by our programmers 
free of charge.  Please call 1-877-477-6947 for assistance. 
 
Before printing barcodes, ensure that a barcode printer is connected and 
its drivers installed.  Also ensure that a Default Label Format and a 
Default Label Printer have been selected in the Preferences and Settings 
section. 
 

 
 

Figure 53. Barcode Label Settings 
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4.1 Barcode Label Part Numbers 
A number of different label types and sizes can be used when printing 
labels from Stock Manager.  Here is a list of some popular label with their 
part numbers: 
 
Cognitive Labels: 

Direct Thermal 2.25” x 1”, Part Number: 03-02-1519 
 

Zebra Labels: 
Direct Thermal 1.25” x 1”, Part Number: 10010038 
Direct Thermal 2.25” x 1.25”, Part Number: 800262-125 
 

Epson Labels: 
Direct Thermal 2.2”x1”, Part Number: 111197200 

 
Barcode label formats can be customized for free by our staff.  Please 
contact us for label formatting. 

4.2 Printing Using the Barcode Label Queue 
The Barcode Label Queue is simply a way to create a barcode print job 
by selecting items to print and then executing the print job so all barcode 
labels print at once.  Queuing labels makes barcode label print jobs 
quicker and more efficient. 
 
Warning:  the Barcode Label Queue will be erased when exiting the 
application.  The queue is only saved while Stock Manager is running. 
 
Selecting Items for the Queue: 

1. Ensure that Queue Barcodes is checked in the Barcode Settings 
tab in Preferences and Settings. 

2. Click on the print button for the desired item from the Inventory 
tab. 

3. A prompt will appear asking how many barcodes should be 
printed for the item.  It will default to the current quantity in stock. 

4. Click OK to add the quantity to print to the queue. 
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Figure 54.  Adding barcodes to the print queue 
 
To Send a Label Queue to the Barcode Printer: 

1. Click on the Print Barcodes button from the Main Screen. 
2. The Barcode Queue will display. 
3. Click on Print Queue to print labels for the items in the Queue. 
 

To Print A Barcode Label for Every Item: 
1. Click on the Print All Items button.  This function will use the 

current inventory quantities.  For example, if there are 54 widgets 
with Item Number 123, Stock Manager will print 54 labels for this 
item. 

 

 
 

Figure 55. Printing Labels from the Queue 
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The Print Random Barcode tab is a function designed to print barcodes 
that may not be in the inventory such as shelf labels, user names, rack 
labels, and anything that might need to be encoded. 
 
To Print a User Defined Barcode: 

1. Click on Print Barcodes and select the Print User-Defined 
Barcode tab.   

2. Scan or type the Barcode data into the Barcode Data field. 
3. Enter a Quantity of labels to print. 
4. Click Print. A label will print to the default label printer. 

 

 
 

Figure 56.  Printing User-Defined Barcodes 

4.3 Individual Item Barcode Label Printing 
With the Queue Barcodes feature turned off barcodes are printed straight 
from the Inventory Tab and from the Print Barcodes button on the main 
screen. 
 
There are three methods for printing barcodes for individual items: 

• From the Main Screen’s Print Barcodes button.  With Queuing 
turned off this will print a barcode for every item in inventory. 

• From the Main Screen Inventory tab’s Barcodes column. 
• When synchronizing inventory values with a mobile device. 
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On the Main Inventory screen, clicking the Print button for any inventory 
item will generate the prompt shown in Figure 56.  Enter the number of 
labels to print and click OK to print them to the default barcode printer. 

 

 
 

Figure 57. Printing Labels for Individual Items 
 

4.4 Mobile Barcode Label Printing 
Barcode Label printing is also available using a mobile barcode scanner 
and a mobile barcode printer.  Both Bluetooth and cabled serial 
connections are supported. 
 
The following printers are supported: 

1. Epson Mobilink TM-P6 
2. Zebra QL220, RW220 and MZ220 series printers 
3. Datamax-Oneil OC2 
4. Most Epson Compatible Mobile Printers 

 
The following 2”x1” Label Stock is supported: 

1. Epson – BSC009313A 
2. Zebra - LD-R7BL5B 
3. Datamax-Oneil - 740525-911 

 
Please refer to Section 12.11 for more information on setting up Mobile 
Barcode Label Printing. 
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5 Inventory Reporting 
Stock Manager includes 6 basic inventory reports: 

• Full Inventory Report 
• Low Inventory Report 
• Three Physical Comparison Reports 
• History Report 
 
 

 
 

Figure 58. Selecting an Inventory Report 
 
Comparison reports are available once comparison scans are entered 
into the Compare Grid from either the Keyboard Wedge scanner or from 
a Wireless Barcode Scanner. 
 
All reports can be printed to the Default Report Printer.  Make sure the 
Default Report Printer in the Preferences and Settings Screen has been 
selected before printing a report. 
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5.1 Full Inventory Reporting 
The Full Inventory Report shows all information for every item.  This 
report also lists the Total Inventory Value at the bottom of the report. 
 

 
 

Figure 59. Full Inventory Report 

5.2 Low Inventory Reporting 
The Low Inventory Report lists items whose Low Inventory threshold has 
been reached.  This report is helpful for reordering and increasing 
inventory turns. 
 

 
 

Figure 60. Low Inventory Report 
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5.3 Comparison of Physical Inventory Reporting 
There are three Comparison reports.  These reports are used when 
conducting a Physical Inventory to determine the accuracy of inventory 
values listed in the database as compared to the actual physical 
inventory values. 
 
A typical Comparison session involves one or more mobile barcode 
scanners scanning and recording current quantities for every item in the 
inventory. 
 

 
 

Figure 61. Selecting a Comparison Report 
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5.3.1 Items Scanned Compared to Stock Manager Levels 
The Comparison report shows the difference between the quantities 
scanned and the values held in the inventory database. 
 

 
 

Figure 62. Inventory Comparison Report 
 
 

5.3.2 Items Scanned but Not in Stock Manager 
The Items Scanned but Not In Inventory Report shows the items present 
in the physical inventory but missing from the Stock Manager database. 
 

 
 

Figure 63. Items Not Found Report 
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5.3.3 Items in Stock Manager but Not Scanned 
This report shows all the items existing in the Stock Manager database 
but not scanned during the Physical Inventory process. 

 

 
 

Figure 64. Items Not Scanned Report 
 
 

5.4 Item History Reporting 
The history report displays all inventory activity for a specific date range. 

 

 
 

Figure 65. Selecting a Date Range 
 
All inventory functions are recorded in a history list and can be viewed for 
a date range or a single day.   
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5.5 User History Reporting 
 

 
 

Figure 66. Selecting a Date Range 
 

5.6 Invoice History Reports 
Reports can be generated for past invoices by user or by customer. 
 

 
 

Figure 67. Select an Invoice report by User. 
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The invoice report shows all of the invoices run by a user for a given date 
range and a grand total of the invoice price. 
 

 
 

Figure 68. User Invoice Report 
 

The Invoice Report by customer is similar to the User Invoice Report 
except that the Invoices and totals are grouped by customer. 
 
Please contact Proxis Software for custom modifications to any report. 
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6 Inventory Tools 
The Inventory tools menu option offers functions such as Manage Users, 
Manage Customers, and Manage Vendors.  These functions are 
explained in detail in the Getting Started section.  
 
Four other functions will clear data from the database and are protected 
by an Administrative password.  These functions will delete data and are 
not reversible. 
 

  
 

Figure 69. Inventory Tools 

6.1 Administrative Password 
The Admin Password helps protect data from being deleted accidentally.  
This password is set initially in the Stock Manager Setup Wizard.  The 
password can also be changed from the login prompt in Figure 70. 

 

 
 

Figure 70. Administrative Password Protection 
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Figure 71. Delete Confirmation 
 

To Zero Inventory Quantities: 
1. Click on Tools > Zero Quantities 
2. Enter the Administrative Password 
3. Click Ok 
4. Click Yes when the Delete Confirmation prompt appears.   

 
To Clear Users: 

1. Click on Tools > Clear Users 
2. Enter the Administrative Password 
3. Click Ok 
4. Click Yes when the Delete Confirmation prompt appears.   

 
To Clear the History: 

1. Click on Tools > Clear History 
2. Enter the Administrative Password 
3. Click Ok 
4. Click Yes when the Delete Confirmation prompt appears.   

 
To Clear Closed Invoices: 

1. Click on Tools > Clear Closed Invoices 
2. Enter the Administrative Password 
3. Click Ok 
4. Click Yes when the Delete Confirmation prompt appears.   
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Figure 72. Changing the Administrative Password 
 

To Change the Administrative Password: 
1. Click on File > Preferences and Settings 
2. Click on Change Password on the General Options tab. 
3. Enter the old password.  Leave this field blank if nothing was 

entered during the Setup Wizard. 
4. Enter the new password. 
5. Retype the new password for confirmation. 
6. Click OK. 
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7 Backing up Data 
Frequent Inventory Database backups are recommended when using 
Stock Manager.  The Backup Inventory screen simply saves a copy of 
the Inventory database to a different location.   
 

 
 

Figure 73. Selecting a Backup Location 
 
It is important to back up the database periodically.  It is also important to 
back up the database to a different location ie separate computer, jump 
drive or external hard drive.   
 
When using Stock Manager in a networked configuration, with a single 
database and numerous clients connected to that database, it is 
important to back up the database when client computers are not using it 
otherwise data might be lost. 
 
To restore a backup: 

1. Copy the backup file to the inventory database location.  The 
inventory database location is typically:  C:\Proxis 
Software\Stock Manager.   

2. Rename the backup file to “Inventory”. 
3. Open Stock Manager normally. 

 
Please call the Proxis help desk at 1-877-477-6947 if a problem is 
encountered restoring the database from a backup. 
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8 Importing Data 
Stock Manager can import a Comma Separated Value (CSV) text file of 
item or product information into the inventory database.  This type of file 
is sometimes called a flat file or comma delimited data file.   
 
The file is typically a standard text file with a .csv or .txt extension and 
must have a specific format to import properly. 
 

 
 

 
 

Figure 74. Import Inventory 
 

 
File Format: 

• Each column must be separated by a comma 
• The first line must exactly match the field name in the inventory 

table where the data will be imported.  See Figure 76 for a list of 
valid field names. 
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• Each line after the first must contain a value for each of the field 
names specified in the first line, and the values must appear in 
the same order. 

• Text information in the file must be enclosed in double-quotes (“), 
single-quotes (‘) or nothing. 

• The field Item_Number is required, and cannot contain any 
double-quotes (“). 

 
To see an example of a valid import file, export the inventory using the 
Export to File function.  Click Reports > Export to File > Full File.  Open 
the file it creates in Notepad or Wordpad, and use this as an example for 
creating your own import file. 
 

 
 

Figure 74a.  Importing the CSV file 
 

To import an inventory file: 
 

1. Open the import window: File->Import Inventory 
2. Click Browse, then locate and click the (.CSV) file to import. 
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3. Choose your text delimiter.  This is the character that encloses 
the text information in the import file.  Valid choices are single-
quote (‘), double-quote (“) or nothing. 

4. Choose whether to replace all the items in the inventory with the 
items in your file, or merge the import file with the existing items.  
Items are matched by Item_number.  WARNING: Replacing your 
existing inventory will permanently delete all the items in the 
database.  This cannot be reversed! 

5. Click Check File.  This verifies that field names were included at 
the top of the file.  It also checks that all of those fields are valid 
field names, and that the Item_Number field is present. 

6. (Optional) Click Test File.  This will simulate an import without 
making any modifications to the inventory database.  The result 
of the output is shown on a grid on the import window.  Verify 
that everything was imported correctly before clicking import and 
altering the database. 

7. Click Import.  Depending on the number of items in the CSV file, 
this can take several minutes.  A window will appear to show the 
progress of the import.  When the import is completed, a 
summary will display with the results of the import. 

 
 

 
 

Figure 75. Sample CSV File 
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Field Names for Inventory Import: 
 
Item_number Unique identifier for the item, usually the barcode 
Qty The quantity in inventory 
Description Description of the item 
Vendor_code Name of the vendor for this item 
Current_cost The cost of the item 
Standard_price The sell price of the item 
List_Price The list price of the item 

Location 
The item's location (Aisle 6, Shelf 3C, Warehouse 2, 
etc) 

Min 
The minimum amount you want to have in stock (the 
reorder point) 

Max The max qty you want to have in stock (reorder up to) 
Notes Notes for this item 
Tax_rate1 Set to 1 to enable Tax1 for this item, 0 to disable 
Tax_rate2 Set to 1 to enable Tax2 for this item, 0 to disable 

 
Figure 76. Import Text File Specification 

 
 
 



ProxisSoftware.com Customer Service: 1-877-477-6947 77

9 Exporting Data 
Exporting the contents of the Stock Manager database to an external 
application is simple.  The Export CSV File screen will export the entire 
Stock Manager database as a comma separated file (CSV) to the 
location specified when clicking the Select button. 
 

 
 

Figure 77. Selecting an Export Location 
 
There is also the option to export a file containing a specific Item Number 
and Quantity only.  This can be handy for updating inventory quantities in 
other applications. 
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10 Synching with Store Manager 
Stock Manager will act as a conduit from Proxis Store Manager to a 
mobile barcode scanner.  Stock Manager will send items to the mobile 
device where they can be scanned for price lookup, label printing, 
location changes, receiving items, and shipping items. 
 

 
 

Figure 78. Sync with Store Manager 
 

Note:  Store Manager is typically installed to the following directory:  
C:\WinPOS40\posdata\products.mdb.  If Stock Manager does not find 
the Store Manager database in this directory, on the local computer, a 
prompt will appear for its location.   
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11 Error Handling 
If Stock Manager encounters errors it will display a brief message 
indicating that there was an error.  Stock Manager also records the error 
in a file named ErrorLog.txt that will be created in the c:\Proxis 
Software\Stock Manager\ folder.   
 
Typical errors might include: 

1. Network connection failure (multi-user mode). 
2. Drive connection failure. 
3. File missing errors. 
4. Security and Permission Issues. 

 
If an error occurs please contact us at 1-877-477-6947.
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12 Using the Cipher Lab 8000 Barcode Scanner 
Proxis Stock Manager is typically preloaded as the default application on 
the scanner.  To turn on the scanner, hold down the power button for one 
second.  Stock Manager will then initialize. 

12.1 Scanner Functions 
Stock Manager has the following scanner functions: 

1. Add To Inventory 
2. Subtract/Remove From Inventory 
3. Compare Inventory 
4. Replace Inventory 
5. Lookup Item Information 
6. Synchronize the Device 
7. File Clearing Utility 
8. Device Memory Status 
9. Scanner Settings 

 
To access a function, press the corresponding number on the keypad.   
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Figure 79. Scanner Main Menu 
 

• The Blue button functions as the Enter key for most scanner 
functions.   

• The Up and Down arrows are used on the scanner’s main 
screen to scroll through the menu.   

• The Up and Down arrows are used in scanning screens to scroll 
through the records of scanned data. 

 
The Battery Level Indicator in the lower right hand side of the screen 
shows the current charge of the battery. 
 
 

== Main Menu == 
1 Add Inventory
2 Remove Inv
3 Compare Inv
4 Replace Inv
5 Lookup Inv
6 Synchronize

Remove Inventory 

Compare Inventory 

Synchronize Data

Memory Status

Add Inventory 

Look up Inventory 

Replace Inventory Qty 

Clear Memory 

Battery Level 
Indicator 

Scroll Indicators 
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12.2 Advanced Scanner Settings 
The 8000 Series Barcode Scanner has an Advanced Settings screen 
that controls functions such as: 

• Loading New Versions of the scanner application. 
• Changing the scanner “beep” settings. 
• Initializing the scanner memory. 
• Running diagnostic tests. 

 
To Enter the Advanced Setting mode: 

1. Ensure the scanner is powered off. 
2. Hold the 7 and 9 buttons down while powering the scanner on. 
3. The 7 and 9 buttons must be pressed and held while the power 
button is activated to enter the advanced screen. 

 
For more information on the 8000 Series Advanced settings please 
contact the Proxis help desk at 1-877-477-6947. 
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12.3 Add Inventory 
The Add Inventory function is used to increase the stock quantities of 
inventory items by scanning their barcodes or manually entering an item 
number.  If the item isn’t found in the scanner database, a prompt will 
ask if it should be added to the database. 
 

 
 

Figure 80. Add To Inventory 
 
To add a single quantity to an existing item:  

1. Scan each item (scanner will beep). 
2. The stock quantity will be increased by one for each item 

scanned. 
 
 

Add Inventory
 

Item Number:
0912309993
Qty:  1
Rec: 1/1

Enter Button

Scanner Activator 

Backspace

Next Record 

Alpha/Numeric 
Keypad 

Escape to Main 
Menu 

Previous Record 
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To add a large quantity to an existing item: 
1. Scan the item for which the quantity will be added. 
2. The scanner will beep and advance to the next record. 
3. Press the Up Arrow key to return to the previous record. 
4. Press the Blue key.   
5. Enter in the quantity to be added. 
6. Press the Blue key again. 

 
To manually key in an item without a barcode: 

1. Key in the number with the keypad.  (Refer to Appendix A for 
instructions on using the Alpha keypad). 

2. Press the Blue button.   
3. Enter the quantity to be added. 
4. Press the Blue button. 
5. The scanner will beep confirming a quantity increase for the 

designated item. 
 
If an item scanned is not in the scanner’s inventory list, a prompt will 
appear asking the user whether to add the item to the Master DB (aka 
Item List).  This action adds the item but does not set any of its 
properties such as description, cost, price, etc.   
 

 
 

Figure 81. Add New Items 
 
After adding an item to the Item List, use function 5 – Lookup Inventory – 
from the Main Menu to modify the item’s properties. 
 
When finished, press the ESC button to exit to the Main Menu. 

Add Master Item 
Add this Item
To the Master DB? 

[1] for Yes
[0] for No
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12.4 Remove From Inventory 
Use the Remove from Inventory function to remove items from inventory.  
This function won’t remove the item completely; it simply subtracts the 
item’s quantity in the inventory database.  The default quantity is 1 (one).  
If the item is not found in the scanner’s item list, a prompt will ask 
whether it should be added to the inventory list. 
 

 
 

Figure 82. Subtract From Inventory 
 
This function works just like the Add to Inventory function in section 12.3 
 
To subtract a single unit from inventory: 

1. Scan each barcode for items you wish to deduct from inventory 
(scanner will beep). 

2. The stock quantity will be decreased by one for each item 
scanned. 

 
To subtract a large quantity from an existing item: 

1. Scan the item for which the quantity will be subtracted. 
2. The scanner will beep and advance to the next record. 
3. Press the Up Arrow key to return to the previous record. 
4. Press the Blue key.   
5. Enter in the quantity to be subtracted. 
6. Press the Blue key again. 

 
To manually key in an item without a barcode: 

1. Key in the number with the keypad.  (Refer to Appendix A for 
instructions on using the Alpha keypad). 

2. Press the Blue button.   
3. Enter the quantity to be subtracted. 
4. Press the Blue button. 

 
When finished, press the ESC button to exit to the Main Menu. 

Remove Inventory 

Item Number:

Qty:  1
Rec: 1/1
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12.5 Compare Inventory Quantities 
Use this function to scan physical inventory and compare the scanned 
information to the item quantity levels in the Stock Manager inventory 
database. 
 

 
 

Figure 83. Compare Inventory Quantities 
 

This function works like Add Inventory and Remove Inventory.  Please 
refer to section 12.3 for scanning instructions. 
 
Scan each item or scan one and then change that item’s quantity.  After 
synchronizing, the scanned data is sent to the desktop for comparison.   
 
When finished, press the ESC button to exit to the Main Menu. 

Compare Inventory 

Item Number:

Qty:  1
Rec: 1/1
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12.6 Replace Inventory Quantities 
 

 
 

Figure 84. Replace Inventory Quantities 
 

This function is similar to the Add Inventory and Remove Inventory 
functions.  Please refer to section 12.3 for scanning instructions. 
 
After synchronizing, the inventory values in Stock Manager will be 
replaced by the quantities assigned to each item using the Replace 
Inventory function.   
 
When finished, press the ESC button to exit to the Main Menu. 
 

Replace Inventory 

Item Number:

Qty:  1
Rec: 1/1
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12.7 Lookup Inventory   
This function allows the user to perform lookup and editing tasks for 
inventory information with the mobile barcode scanner.   Lookup times 
should be less than one second, even with thousands of items.   
 

 
 

Figure 85. Lookup Items 
 
Edit description, price, cost, list price, quantity, location and vendor for 
each item in the Item List.  Changes and additions are sent back to Stock 
Manager.   
 
To change the value of an item: 

1. Scan the item. 
2. Use the Up and Down arrows to scroll to the field to be changed. 
3. Enter the item information using the keypad. 
4. Press the Blue button to save your changes. 

 
Be sure to press the Blue button prior to exiting.  Changes are not 
saved unless a Blue button is pressed.  Make sure to turn off the Alpha 
Keyboard function before exiting. 
 
Refer to Appendix A for instructions on using the Alpha keypad.   
 
When finished, press the ESC button to exit to the Main Menu. 
 
 
 
 
 
 

Lookup Inventory 

Please
 Scan an
  Item

Esc to Exit
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12.8 Synchronize 
The Synchronize function is used to send scanned data to the Stock 
Manager database.  This function will also transfer inventory levels and 
item information to the device. 
 

 
 

Figure 86. Synchronize the Device 
 
To synchronize the device: 

1. Make sure the cradle has power and is connected to the 
computer’s USB port. 

2. Place the scanner in the cradle. 
3. From the Main Menu, Press 6. 
4. Press the Blue button. 
5. Click the Synchronize option on the Stock Manager desktop 

application. 
6. Click Ok when prompted. 

 
If synchronization does not occur immediately, click the Abort button on 
the desktop and perform steps 5 and 6 again. 
 
When finished, press the ESC button to exit to the Main Menu. 
 

 Synchronize 
 

Place in Cradle
Press Blue Key

Esc to Cancel
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12.9 Utility 
The Utility function allows the user to delete the scanned data from one 
or all of the data tables on the barcode scanner. 
 

 
 

Figure 87. Clear Data Utility 
 
Caution:  The Clear Data functions are not reversible.  These functions 
will erase all collected information. 
 
When finished, press the ESC button to exit to the Main Menu. 

12.10 Status  
The Status screen displays the amount of memory each function is using 
and the amount of memory left on the device.   
 

 
 

Figure 88. Memory Status 
 
Typically, a 2MB scanner will scan over 15,000 items before running out 
of memory. 
 
When finished, press the ESC button to exit to the Main Menu. 

Add Inventory 
1. Clr Add Inv.
2. Clr Sub Inv. 
3. Clr Compare
4. Clr Replace
5. Clr Add New

7. Clear All
6. Clr Lookup

= Statistics = 
Add Inv  1
Sub Inv  0
Cmp Inv  902
Rep Inv  0
AddNwInv 4

Free Mem 190976 
Look Inv 902
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12.11 Scanner Advanced Settings  
The Scanner Table configures the 8000 Series barcode scanner for 
specific scanner settings.  Support for ISBN barcodes can be turned on 
or off.  Lead digits can be enabled or disabled.  The scanner can even be 
restricted to only scan a certain barcode type. 
 

 
 

Figure 89. Scanner Table 
 
Please call your vendor or the Proxis tech support department for 
assistance when configuring Advanced scanner settings. 
 
When finished, press the ESC button to exit to the Main Menu and save 
any changes. 
 
 
 

Scanner Table
1: 9B C9 00 3F 80 
2: 21 54 80 00 9C 
3: BF 10 C0 01 C0 
4: 01 C0 01 C0 01 

Press Esc  Exit 
5: 66 03 03
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13 Using Palm Barcode Scanners 

 
Figure 90. A Palm Barcode Scanner 

 
Stock Manager Palm offers a mobile inventory management application 
for standard Symbol Palm barcode scanners like the Janam XP series 
and the Aceeca IDVERIFI. 

13.1 Sending Inventory Data to the Scanner 
To load inventory items onto the device: 

1. Place Scanner in synch cradle. 
2. Start the Stock Manager program on the PC. 
3. Ensure that the Palm device is set as the default scanner in the 

preference menu. 
4. Click Synchronize in the menu bar of Stock Manager Desktop. 
5. Press the synchronize button on the cradle. 

 

Stock Manager 
Icon 
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Figure 91. Device Synchronization 
 
When synchronizing information with the Palm pilot, the current user is 
associated with the scans from the device. 
 
To set the current user when synchronizing: 

1. Click on Change User in the upper right hand corner of any tab. 
2. Select the correct user. 
3. Synchronize the device. 
4. The current user will be associated with all of the scans on the 

device.
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13.2 Scanner Functions 
The Palm version has the following basic scanner functions: 
 

1. Add To Inventory 
2. Subtract/Remove From Inventory 
3. Compare Inventory 
4. Replace Inventory 
5. Lookup Item Information 
6. Edit Item Information 
7. File Clearing Utility 

 
The Palm version also features more advanced user input screens and 
increased memory. 
 
Main Menu: 
To access a function, tap on the corresponding icon on the touch screen.   

 
Figure 92. Scanner Main Menu 

Remove Inventory 
Quantities 

Increase Inventory 
Quantities 

Replace Inventory 
Quantities 

Add New Items 

Compare Physical 
Inventory 

Item Calculator 
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13.3 Add Inventory 
The Add Inventory function offers the ability to increase stock quantities 
by scanning their barcodes or manually entering a number. 

 
Figure 93. Add To Inventory 

 
To increase inventory quantities by a single unit:  

1. Scan each item (scanner will beep). 
2. The stock quantity is increased by one for each item scanned. 
3. The barcode scan is entered into the list. 

 
To increase an item by a number larger than one: 

1. Enter the total quantity in the Quantity field. 
2. Scan the item. 
3. The scanner will beep confirming a quantity increase for the 

designated item. 
4. The scan is entered into the list. 

 
To manually key in an item without a barcode: 

1. Tap the Barcode field. 
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2. Tap the numbers or letters that make up the barcode number.   
3. Tap on the Done button. 
4. Tap the Enter button. 
 

 
 

Figure 94. Adding a New Item to Inventory 
 
If an item’s barcode is not found in the current database, the scanner will 
prompt to add it.  If the item is not added to the product database, the 
quantity increase will be ignored. 
 
To exit to the Main Menu, press the Return button. 
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13.4 Subtract From Inventory 
Use the Subtract Inventory function to remove items from inventory.  This 
function will not remove the whole item; it simply deducts an item’s 
quantity from your inventory records. 
 

 
Figure 95. Subtract From Inventory 

 
To decrease inventory quantities by a single unit:  

1. Scan each item (scanner will beep). 
2. The stock quantity is decreased by one for each item scanned. 
3. The scan is entered into the list. 

 
To decrease an item by a number larger than one: 

1. Enter the quantity in the Quantity field. 
2. Scan the item’s barcode. 
3. The scanner will beep confirming a quantity decrease for the 

scanned item. 
4. The scan is entered into the list. 
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To manually key in an item without a barcode: 
1. Tap the Barcode field. 
2. Tap the numbers or letters that make up the barcode number.   
3. Tap on the Done button. 
4. Tap the Enter button. 

 
To exit to the Main Menu, press the Return button. 
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13.5 Compare Inventory Quantities 
Use this function to scan physical inventory and then compare the 
scanned information to item quantity levels in the Stock Manager 
inventory database. 
 

 
 

Figure 96. Compare Inventory Quantities 
 

This function works like the Add To Inventory and Subtract from 
Inventory functions.  Please refer to section 13.4 for scanning 
instructions. 
 
Scan each item or scan one and then change that item’s quantity.  After 
synchronizing, the scanned data is sent to the desktop for comparison.  
Refer to section 3.5 for Comparison Report options. 
 
To exit to the Main Menu, press the Return button. 
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13.6 Replace Inventory Quantities 
 

 
 

Figure 97. Replace Inventory Quantities 
 

This function is similar to the Add To Inventory and Subtract Inventory 
functions.  Please refer to section 13.4 for scanning instructions. 
 
After synchronizing, the inventory values in Stock Manager will be 
replaced by the quantities from the Replace Inventory function.   
 
To exit to the Main Menu, press the Return button. 
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13.7 Add New Inventory Item 
The Add New Inventory function will add new items (items not currently 
existing) in the Stock Manager database.   
 

 
Figure 98. Add New Inventory Items 

 
To add a new item: 

1. Press the New Item button on the Scanner’s main screen. 
2. Scan or key in the barcode number.  The scanner will check to 

see if it is already in the system. 
3. Key in information using the keypad  
4. Press Save to add the new item. 

 
To exit without saving: 

1. Press the Return button. 
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The Palm soft Keypad provides an easy method for entering and editing 
product information.  Access the soft keypad by tapping inside each field.  
Numeric fields will show the number keypad and text fields will show the 
text keypad. 
 

 
 

 
 

Figure 99. Palm Soft Numeric and Text Keypads 
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13.8 Lookup Products   
This function performs a lookup on item information with your Stock 
Manager barcode scanner.   Lookup times should be less than one 
second, even with thousands of items.   
 

 
 

Figure 100.  Lookup Inventory Items 
 
Lookup Quantity and Location: 

1. Scan or enter the item’s barcode. 
2. If found, the item will be highlighted in the Item List. 
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Lookup All Item Information: 

1. Ensure the Show On Find box is checked (see example in Figure 
100.). 

2. Scan or enter the item’s barcode. 
 

 
 

Figure 101. Show Scanned Item Information 
 
To exit to the Main Menu, press the Return button. 
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13.9 Edit Inventory Information 
Scan an item to edit any of the following fields: Description, Quantity, 
Cost, Price, MSRP or List Price, Location and Vendor.  Changes are 
automatically sent from the Barcode Scanner to Stock Manager during 
the synchronization process. 
 

 
 

Figure 102. Lookup Inventory Quantities 
 

 

 
 

Figure 103. Lookup Inventory Quantities 
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13.10 Palm Mobile Barcode Printing 
The Printer Setup screen is used to set up a Mobile printer for printing 
barcodes via a serial cable connection.   

 

 
 

Figure 104. Mobile Printing Setup 
 

To set up a mobile label printer to print barcodes: 
1. Ensure that the label printer is connected to the scanner.   
2. Select the printer from the Select Printer list. 
3. Select the Port assigned to the printer.  Serial cabled printers 

usually use Com Port 1.  Bluetooth printers are not supported on 
the Palm version but are supported on the Window CE version. 

4. Select a default Print Quantity. 
• One Barcode  
• Scanned Quantity - will print the number of items based on the 

Qty field. 
• Total Quantity - will print barcodes for the total number of 

items in inventory. 
5. Select the Auto Print on Add Qty.  This will automatically send a 

label print command when adding inventory quantities from the 
Add screen. 

6. Select any additional information to print on the barcode label. 
• Barcode Text – prints the barcode number under the barcode. 
• Description – prints the item description above the barcode. 
• Price – prints the item price to the right of description. 

 
The following printers are supported: 

1. Epson Mobilink TM-P6 
2. Zebra QL220, RW220 and MZ220 series printers 
3. Datamax-Oneil OC2 
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4. Most Epson Compatibles 
 
The following 2”x1” Label Stock is supported: 

1. Epson - BSC009313A 
2. Zebra - LD-R7BL5B 
3. Datamax-Oneil - 740525-911 
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13.11 Synchronize the Palm Scanner 
The Synchronize function is used to send scanned data to the Stock 
Manager database.  This function will also transfer the inventory levels 
and item information to the device. 
 

 
Figure 105. Synchronize the Device 

 
To synchronize the device: 

1. Make sure the cradle has power and is connected to the 
computer’s USB or serial port. 

2. Place the scanner in the cradle. 
3. Press the Synchronize button. 
4. Press the Synchronize button on the Stock Manager desktop 

application. 
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13.12 Data Utility 
The Utility function allows deletion of scanned data from one or all of the 
data tables on the barcode scanner. 
 

 
 

Figure 106. Main Menu Drop Down 
 
 

 
 

Figure 107. Clear Data Utility 
 
 

Caution:  The Clear Data functions are not reversible.  These functions 
will erase all collected information. 
 
To exit to the Main Menu, press the Return button. 
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13.13 Palm Device Status  
The Status screen displays the number of records each function is using. 
 
Typically, an 8MB scanner will scan well over 20,000 items before 
running out of memory. 
 
To exit to the Main Menu, press the Return button. 
 

 
 

 Figure 108. Clear Data Utility 
 
 
 
 
 
 
 
 
 



ProxisSoftware.com Customer Service: 1-877-477-6947 111

13.14 Calculator Function  
The Item Calculator tallies both the Total Price and Total Cost for items 
scanned from this screen.  Items must be entered into the product 
database and must have either a Price or a Cost respectively to add the 
item to the running total.   
 
The Item Calculator does not add sales tax or perform any point-of-sale 
functions. 
 
To exit to the Main Menu, press the Return button. 
 

 
 

 Figure 109. Item Calculator 
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14 Using Windows CE Barcode Scanners 
Stock Manager Mobile version will work on a number of standard 
Windows Mobile and Windows CE wireless barcode scanning devices 
(also termed Mobile Scanners or Mobile Computers). 
 

 
 

Figure 110. Stock Manager CE  
 

Windows Mobile is based on a Windows CE platform but has a different 
look, is designed for mobile phones and wireless devices, and usually 
comes with additional applications like Word and Excel.  Stock Manager 
is compatible with Windows CE 5.0 and Windows Mobile 5 and 6. 
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14.1 Device Compatibility 
Supported Windows Mobile and Windows CE devices by manufacturer 
include but are not limited to: 
 
Honeywell: 

• Dolphin 7000 Series 
• Dolphin 9000 Series 

 
Motorola: 

• MC3000 Pro 
• MC55 
• MC70 
• MC9000 Series 

 
Janam: 

• XM60 
• XM65 
• XG100 

 
Unitech: 

• All unitech Windows CE based scanners 
 
Datalogic: 

• Falcon series 
• Pegasso series 
• Memor (by request) 
• Skorpio (by request) 

 
Please contact our Customer Service desk for additional assistance at 1-
877-477-6747. 
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14.2 Sending Inventory Data to the Scanner 
To load inventory items onto the device: 

1. Place Scanner in synch cradle. 
2. Exit Stock Manager on the device. 
3. Start the Stock Manager program on the PC. 
4. Ensure that the scanning device is set as the default scanner in 

the preference menu. 
5. Click Synchronize in the menu bar of Stock Manager Desktop. 
6. Click Start to import data from the scanner. 

 

 
 

Figure 111. Device Synchronization 
 
When synchronizing information with the Windows CE barcode scanner, 
the current user is associated with the scans from the device. 
 
To set the current user when synchronizing: 

1. Click on Change User in the upper right hand corner of any tab. 
2. Select the correct user. 
3. Synchronize the device. 

The current user will be associated with all of the scans on the device.
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14.3 Scanner Functions 
The Windows CE version has the following basic scanner functions: 
 

1. Add To Inventory 
2. Subtract/Remove From Inventory 
3. Compare Inventory 
4. Edit Item Information 
5. Lookup Item Information 
6. Calculate Prices  
7. Setup Mobile Printers 

 
Main Menu: 
To access a function, tap on the corresponding icon on the touch screen.   

 
Figure 112. Scanner Main Menu 

 

Remove Inventory 
Quantities 

Increase Inventory 
Quantities 

Add New Items 

Edit Item Information 

Compare Physical 
Inventory 

Item Calculator 
Lookup Items 

Setup Mobile 
Barcode Printer 
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14.4 Add To Inventory 
The Add Inventory function will increase stock quantities.  Simply scan 
barcodes or manually enter the item number.  Default quantity is one. 

 

 
 

Figure 113. Add To Inventory 
 
To increase inventory quantities by a single unit:  

1. Scan each item (scanner will beep). 
2. The stock quantity is increased by one for each item scanned. 
3. The scan is entered into the list. 

 
To increase an item by a number larger than one: 

1. Enter the total quantity in the Quantity field. 
2. Scan the item. 
3. The scanner will beep confirming a quantity increase for the 

designated item. 
4. The scan is entered into the list. 

 
To manually key in an item without a barcode: 

1. Tap the Barcode field. 
2. Tap the numbers or letters that make up the barcode number.   
3. Tap on the Done button. 
4. Tap the Enter button. 
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Figure 114. Adding a New Item to Inventory 
 
If an item’s barcode is not found in the current database, the scanner will 
prompt to add it.  If the item is not added to the product database, the 
quantity increase will be ignored. 
 
To print a barcode of the last item scanned: 

1. Ensure that the mobile printer is connected or via a serial cable 
or the Bluetooth connection manager. 

2. Ensure that the Printer Settings are set up for the mobile printer. 
3. Tap on the item to print.  
4. Tap on the Print button. 

 
The Mobile Printer Settings can be set to automatically print a barcode 
when the inventory quantity is increased. 
 
To exit to the Main Menu, press the Close button. 
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14.5 Subtract From Inventory 
Use the Subtract Inventory function to remove items from inventory.  This 
function will not remove the whole item; it simply deducts an item’s 
quantity from your inventory records. 
 

 
 

Figure 115. Subtract From Inventory 
 
To decrease inventory quantities by a single unit:  

1. Scan each item (scanner will beep). 
2. The stock quantity is decreased by one for each item scanned. 
3. The scan is entered into the list. 

 
To decrease an item by a number larger than one: 

1. Enter the quantity in the Quantity field. 
2. Scan the item’s barcode. 
3. The scanner will beep confirming a quantity decrease for the 

scanned item. 
4. The scan is entered into the list. 

 
To manually key in an item without a barcode: 

1. Tap the Barcode field. 
2. Tap the numbers or letters that make up the barcode number.   
3. Tap on the Done button. 
4. Tap the Enter button. 
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To print a barcode of the last item scanned: 

1. Ensure that the mobile printer is connected or via a serial cable 
or the Bluetooth connection manager. 

2. Ensure that the Printer Settings are set up for the mobile printer. 
3. Tap on the item to print.  
4. Tap on the Print button. 

 
To exit to the Main Menu, press the Close button. 
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14.6 Add New Inventory Item 
The Add New Inventory function will add new items (items not currently 
existing) in the Stock Manager database.   

 

 
 

Figure 116. Add New Inventory Items 
 

To add a new item: 
1. Press the New Item button on the scanner’s main screen. 
2. Scan or key in the barcode number.  The scanner will check to 

see if it is already in the system. 
3. Key in information using the keypad  
4. Press Save to add the new item. 

 
To exit without saving: 

2. Press the Close button. 
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The Windows CE software Keypad provides an easy method for entering 
and editing product information.  Access the soft keypad by tapping the 
keyboard icon at the bottom of the screen.   
 

 
 

 
 

Figure 117. Software Keypads 
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14.7 Compare Inventory Quantities 
Use this function to scan physical inventory then compare the scanned 
information to item quantity levels in the Stock Manager inventory 
database. 
 

 
 

Figure 118. Compare Inventory Quantities 
 

This function works like the Add Inventory and Subtract Inventory 
functions.  Please refer to section 8.4 for scanning instructions. 
 
Scan each item or enter a Compare quantity before scanning the item for 
entering multiple items at a time.  After synchronizing, the scanned data 
is sent to the desktop for comparison.  Refer to section 4.5 for 
Comparison Report options. 
 
To exit to the Main Menu, press the Close button. 
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14.8 Edit Inventory Information 
Scan an item to edit any of the following fields: Description, Quantity, 
Cost, Price, MSRP or List Price, Location and Vendor.  Changes are 
automatically sent from the Barcode Scanner to Stock Manager during 
the synchronization process. 
 

 
 

Figure 119. Lookup Inventory Quantities 
 
Tap on the item in the list to open the Edit screen. 
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Figure 120. Lookup Inventory Quantities 
 
Change any of the items features in the Edit Item screen.  Barcodes can 
be printed for an item by pressing the Print button. 
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14.9 Lookup Products   
This function performs a lookup on item information with your Stock 
Manager barcode scanner.   Lookup times should be less than one 
second, even with thousands of items.   
 

 
 

Figure 121. Lookup Inventory Items 
 
Lookup Quantity and Location: 

1. Scan or enter the item’s barcode. 
2. If found, the item will be highlighted in the Item List. 
3. Check the Show On Find checkbox to open the Item Information 

screen automatically after a scan. 
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Lookup All Item Information: 

1. Ensure the Show On Find box is checked (see example in Figure 
121). 

2. Scan or enter the item’s barcode. 
 

 
 

Figure 122. Show Scanned Item Information 
 
To exit to the Main Menu, press the Close button. 
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14.10 Calculator Function  
The Item Calculator tallies both the Total Price and Total Cost for items 
scanned from this screen.  Items must be entered into the product 
database and must have either a Price or a Cost entered to add the item 
to the running total.   
 
The Item Calculator does not add sales tax or perform any point-of-sale 
functions. 
 
To exit to the Main Menu, press the Close button. 
 

 
 

Figure 123. Item Calculator 
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14.11  Mobile Printer Setup 
The Printer Setup screen is used to set up a Mobile printer for printing 
barcodes via a Bluetooth or serial cable connection.   
 
Supported Mobile Printers: 

• Epson Mobilink Label Version 
• Oneil MF2Te 
• Oneil OC2 
• Zebra QL220 
• Zebra RW220 

 

 
Figure 124. Mobile Printer Setup 

 
To set up a mobile label printer to print barcodes: 

1. Ensure that the label printer is connected to the scanner.  If 
Bluetooth is used the printer must be assigned a serial port 
through the device’s Bluetooth manager. 

2. Select the printer from the Select Printer list. 
3. Select the Port assigned to the printer.  Serial cabled printers 

usually use Com Port 1.  Bluetooth printer ports are typically 
assigned manually in the device Bluetooth configuration 
manager.  Bluetooth connections will typically use Com 7. 

4. Select a default Print Quantity.  Choose from: 
• One Barcode  
• Scanned Quantity will print the number of items based on the 

Qty field. 
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• Total Quantity will print barcodes for the total number of items 
in inventory. 

5. Select the Auto Print on Add Qty.  This will automatically send a 
label print command when adding inventory quantities from the 
Add screen. 

6. Select any additional information to print on the barcode label. 
• Barcode Text – prints the barcode number under the barcode. 
• Description – prints the item description above the barcode. 
• Price – prints the item price to the right of description. 

 
The following printers are supported: 

• Epson Mobilink TM-P6 
• Zebra QL220, RW220 and MZ220 series printers 
• Datamax-Oneil OC2 
• Most Epson Compatibles. 

 
The following 2”x1” Label Stock is supported: 

• Epson - BSC009313A 
• Zebra - LD-R7BL5B 
• Datamax-Oneil - 740525-911 
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14.12 Data Utility 
The Utility function allows deletion of scanned data from one or all of the 
data tables on the barcode scanner. 
 

 
 

Figure 125. Clear Data Utility 
 
 



ProxisSoftware.com Customer Service: 1-877-477-6947 131

 
 

Figure 126. Clear Data Utility 
 
 

Caution:  The Clear Data functions are not reversible.  These functions 
will erase all collected information. 
 
To exit to the Main Menu, press the Close button. 
 



ProxisSoftware.com Customer Service: 1-877-477-6947 132

14.13 Scanner Database Status  
The Status screen displays the number of records each function is using. 
 
To exit to the Main Menu, press the Close button. 
 
 

  
 

Figure 127. Database Status 
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15 Appendix and Supplemental Information 

15.1 Appendix A:  The 8000 Series Alpha Keyboard 
The Alpha Keyboard feature on the 8000 Series barcode scanner allows 
the user to key in letters using the numeric keypad.  The Alpha Keyboard 
works much like a standard cell phone’s texting function.   
 
To enter an Upper case letter using the keypad: 

1. Press the “ALPHA” key. 
a. An “A” will appear above the battery indicator. 

2. Press the key that has the desired letter. 
a. Example1:  for the letter “A” press the 2 key once. 
b. Example2:  for the letter “B” press the 2 key twice.  

 
To enter a Lower case letter: 

1. Press the “ALPHA” key twice 
a. A small “a” will appear above the battery indicator. 

2. Press the key that has the desired letter. 
a. Example1:  for the letter “a” press the 2 key once. 
b. Example2:  for the letter “b” press the 2 key twice.  

 
Pressing the “ALPHA” key three times will bring up the function 
characters.  This mode is indicated by a “F” above the battery indicator.  
The function characters set is an extension that is rarely used. 
 
To return to numeric input, press the “ALPHA” key until the letter function 
indicator (“A”, “a” or “F”) disappears. 
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15.2 Appendix B:  Device Registration  
The 8000 Series barcode scanner has a simple registration screen.  
Scanners are typically activated before being shipped.  Please contact a 
Proxis Stock Manager reseller to purchase and register a mobile barcode 
scanner. 
 

 
 

Figure 128. 8000 Series Registration Screen 
 
Palm and Windows CE devices will come with a Mobile Device License 
card.  This card will have a barcode that is scanned to unlock the demo 
mode on the device. 
 

 
 

Figure 129.  Splash Screen 

= Register =

Serial No:
EF4002050

Enter Code:
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Figure 130. Scan or Enter the Activation Code  
 

The Stock Manager Mobile Device License is a plastic card with a 
barcoded activation code.  The code is scanned to activate the mobile 
device software. 

 

 
 

Figure 131. Stock Manager Mobile Device License
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15.3 Appendix C:  Installing Palm Files 
Palm files are installed to the device via the Palm HotSync Manager.  
The HotSync Manager is part of the Palm Desktop.  The Palm Desktop 
software must be installed and configured prior to installing the device 
software.  The latest Palm Desktop software can be found at 
www.palm.com. 
 
The HotSync manager will appear in the system tray when installed 
properly. 
 
 
 

 
 

Figure 132. HotSync Icon in System Tray 
 
 
Right click on the HotSync Manager Icon to configure the HotSync 
Manager.  The HotSync Manager must be correctly set up and 
synchronizing with your device to install program files. 
 
To Install Palm Program Files: 

1. Browse to the C:\WinPOS40\Palm Support Files\ directory. 
2. Double click the Install_Palm_Files.exe application. 
3. If the prompt in Figure 133 is displayed, follow the first time 
installation directions below. 
4. Wait a few moments for the HotSync Manager to restart. 
5. Press the hot synch button on the cradle. 

 
 

 
 

Figure 133. First Installation Prompt 

Hot Sync Manager Icon 

Check 
this box 
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First Time Installation: 

1. Check the box on the prompt shown in Figure 133. 
2. Click Yes. 
3. Click Cancel on the prompt in Figure 134. 
4. Restart the installation process. 

 

 
 

Figure 134. Select Palm User Name 
 
 

 
 

Figure 135. HotSync Status 
 
 
 

 


